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The Kodak ScanMate i1120 Series Scanners provide the ability to
process scanned images to improve their quality by using image
processing features.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(i.e., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The ISIS Driver is software that communicates with the scanner. This
driver is created and maintained by EMC Captiva and is provided with
the scanner by Kodak. This driver can be used to interface with many
scanning applications that support ISIS drivers.

The information in this guide provides procedures for using the ISIS
Driver as well as descriptions of the features. The same features should
be available on the user interface of the scanning application you are
using.
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Starting the Scan NOTE: The Scan Validation Tool is provided by Kodak and is a

Validation Tool diagnostic tool only. Kodak does not support the use of the Scan
Validation Tool as a scanning application.

1. Select Start>Programs>Kodak>Document Imaging>Scan
Validation Tool.

& Scan Validation Tool x|

Drriver Types:

Dirivers:

| [

2. Select ISIS for the Driver Type and the KODAK i1120 as the driver
and click OK. The main Scan Validation Tool screen will be

displayed. See the next section for a description of the icons on this
screen.

3. Click the icon to enable the image view panels.

4. Click the Setup icon on the main Scan Validation Tool screen.

£ cc=n validation Tool - 1515 i [m] 4|

1[>][m Gl

v | Sawve [mages To Files Dizplay Even: I
Tatal: Last File: |

The Setup dialog box will be displayed.
setwn x|

— Compression

Front Calar:

JPEG
Frant Bitanal:

Group-4

Fear Color: [hane]
JPEG

Eear Bitonal: [none]
Group-4
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5. Click ISIS. The Preset Configurations dialog box will be displayed.
This dialog box maintains a list of saved driver settings.

You can save, delete or import a preset; or select a preset that is
already set up or one you want to modify.

KODAK 1120 on None x|

r— Preget Configurations
NEl o

Freset Mame

Default

Black and 'white Document with OCR Quality
Black and “White Document

Color Document with OCR Qualiy
Colar Document

Color Phaotograph

Drezcription
Default zettings. ;I
I]
~ Properties
Image. .. Scanner...
oK | Cancel |

6. Click Image to configure settings associated with the image.

The following sections provide descriptions and procedures for
configuring Image settings. See the section later in this chapter

entitled, “"Configuring Scanner settings” for scanner configuration
procedures.
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The Scan Validation
Tool dialog box

The Scan Validation Tool (SVT) is a diagnostic application provided by
Kodak. The SVT user interface allows access to all the features of the
scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS Driver.

£ Scan Yalidation Tool - ISIS =01 =]
[=][=] ][] Gl
¥ Gave mages ToFiles Dizplay Evens I

Tatalk Last File: |

Toolbar buttons

Setup — displays the user interface for the selected driver.

Destination — allows you to select a directory to store scanned
= images and their file names. This option is only available when
Save Images to Files is selected.

3 Start Scanning — scans the documents in the input tray.

=] Scan One Page — scans only one page.

Stop Scanning — ends the scan session.

License Key — displays the License Key window.

No Image Display mode — closes the Image Viewer window
(no images will be displayed).

One Image Display mode — displays one image at a time.

Two Image Display mode — displays two images at a time.

Four Image Display mode — displays four images at a time.

Eight Image Display mode — displays eight images at a time.

About — displays the version of the Scan Validation Tool.

- H BB DO NI

A-61809 May 2013



Save Images to Files — when selected, will save the images to the
specified directory.

Display Every — enter the sampling rate of the images you want to
display while scanning. For example, to see every image, enter a value

of 1. To see every 10t image, enter a value of 10.

Total — displays the total number of images scanned during the current
Scan Validation Tool session.

» To access the ISIS Driver double-click the Setup icon on the Scan
Validation Tool dialog box to access the main Kodak Scanner
window.

Last File — displays the full path and file name for the last stored
image.
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Configuring Image
settings

The main ISIS Driver window provides a set of default tabs for
configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

This section describes the ISIS Driver default interface.

NOTE: The Image Mode selections are available with all of the Image
tabs (i.e., Main, Layout, Image Processing, etc.).

x
Preset: I:::E:é-':::é:
~Image Mode Il:;\c!justmerrts I Image Edge Fill I Blank Image Detection I About I
INorrnaI j ain | Layout I Image Processing I Auto Color Detect I Dropout
Camera: Dotz per inch:
o N - |
[ Front Image #2 ]
[ Back Image #1 Cropping:
[ Back Image #2 IFixed To Trangport j
Binarization:
iThreshalding -
Mode: I J
Black and White = Jhreshold
Grayscale 1 =
Color ) ID _|;
Auto Detect Grayscale ! !
Auto Detect Color ] 255
r— Contrast
1
-+ F 4
-50 50

Copy | 0K | Cancdl | Hep Defaut

Image Mode — select one of the camera options:

» Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image
#2, Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings
independently. Some settings apply only to black and white images,
others apply to color/grayscale images.

* Mode — select one of the following modes:

- Black and White: if you want your electronic image to represent
all elements of your document in black and white.

- Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

- Color: if you want your electronic image to be in color.

- Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

- Auto Detect Color: sets auto color detect for color. See the
section entitled, “Auto Color Detect tab” for more information.
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Buttons — the buttons on the bottom of the window apply to all tabs:

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

* OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.

» Default — resets the values on all tabs to the factory defaults.
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Main tab

The Main tab provides the following options.

x
Preset: I:::E:é-':::é:
~Image Mode ————————— h‘:ﬁi'—'ﬁmem | Image Edge Fil | Blank Image Detection | About |
INorrnaI j ain | Layout I Image Processing I Auto Color Detect I Dropout
Camera: Dotz per inch:
o N - |
[ Front Image #2 ]
[ Back Image #1 Cropping:
[ Back Image #2 IFixed To Trangport j
Binarization:
iThreshalding -
Mode: I J
Black and White = Jhreshold
Grayscale 1 =
Color ) ID _|;
Auto Detect Grayscale ! !
Auto Detect Color ] 255
r— Contrast
1
-+ F 4
-50 50

Copy | 0K | Cacel |  Hep | Defaur |

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Choose a resolution value from the drop-down list. The default is 200
dpi. Available resolutions are: 75, 100, 150, 200, 240, 300, 400, 600
and 1200 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image. Select one of the following options:

» Automatic: dynamically adjusts the cropping window for different
sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide for more
information.
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» Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

» iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (i.e., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (i.e., text, graphics, lines, etc.) from the
background information (i.e., white or non-white paper background).

Threshold — changes the amount of white in the color and grayscale
image. Use the slider to select a value from 0 to 255. The default is 90.

Contrast — adjusts the difference between black and white, thereby
making an image sharper or softer.

The difference between black and white is small with a low contrast
setting, so the image is softer. With a high contrast setting, the
difference between black and white is large, so the image is clearer.
Select a contrast value from -50 to 50. The default is 0.
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Layout tab

The Layout tab provides these options.

Properties for KODAK i1120 on None ﬂ
Preset: [[Defautiz]
~Image Mode ————————— J“\d_il-lsﬂﬂe”ts Lay!:ut Image Edge Fil | Blank Image Detection | About |
INorrnaI j Main Image Processing I Auto Color Detect I Dropout
Camera: Page Size:

Front Image #1

|Letter- 8.5 %11in

[ Front Image #2
[0 Back Image #1
[ Back Image #2

=l
8l ‘I._andsgape
Mode: : = |
- IAutomatlc J

r~ Image Orientation

Black and White
Grayscale

Color

Auto Detect Grayscale
Auto Detect Color

r— Page Orientation

' Top edge first
" Bottom edge first

1 Left edge first
€ Riight edge first
Scan frea... |
Copy | 0K | Cacel |  Hep | Defaur |

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.
Page size should be set to the Scanner’s Maximum when using the
Automatic or Aggressive cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.
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Combine front and back images — typically, for a document, one
image is created for the front side and another image is created for the
back side. Turn this option on if you want one image that contains both
the front side and back side of the document. The selections are:

Back
Front
Front
Back
Front on Top: front side will be above the Front on Bottom: back side will be above
back side within the image. the front side within the image.
Front Back Back Front

Front on Left: front side will be to the left Front on Right: back side will be to the
of the back side within the image. left the front side within the image.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section, “Scan
Area dialog box” for more information.

1
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Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to your PC

x

— Page Layout
* Portrait
" Landscape

]

3]
I

Aea
v Snap

=B

11l

wWhdth: |5 1/2"
Height: |3 172"

Urits:

I Inches

akK. I Cancel |

Page Size — the default paper size is set when a scanner is selected.
You can choose a different paper size using the drop-down list.

NOTE: Page Size and Page Layout selections also appear on the
Layout tab. If you make a change on the Scan Area dialog box,
the same selections will be displayed on the Layout tab and vice
versa.

Page Layout
» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 1/8-inch increments. This option is not available in
Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

» Width: the width of the scanning area.

» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Image Processing tab The Image Processing tab provides these options.

x
Presst: I:}e‘a,:::é:
= o ors Ac!justments I ImageI Edage EII | Blank Image Detection I About I
[Noma = Main | Layout mage Processing | Auto Color Detect | Dropout
Camera: — General Options
Front Image #1 (]
[ Front Image 2 Halftane Remaval
[ Back Image #1 O Irvert Image
[0 Back Image #2 L] Add Border

Document Type

Mode:

Black and White Media Type
Grayscale
Co'_clg'rs IF'Iain Paper j
Auto Detect Grayscale .
Auto Detect Color JPEG Duality
IBetter j
Moize Filker
ILone Pixel j

Copy | ok | Cancel Help Defaut

General Options

» Deskew — automatically straightens a document within £0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is not available
when Fixed to Transport or Relative to Document is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

» Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image.

A-61809 May 2013 13




Document Type
» Text: the documents contain mostly text.

» Text with Graphics: the documents contain a mix of text, business
graphics (bar graphs, pie charts, etc.) and line art.

» Photographs: the documents are comprised mainly of photos.

Media type — select one of the following options based upon the
texture/weight of the paper you are scanning. Available options are:
Plain Paper, Thin Paper, Glossy Paper, Card Stock, Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

* Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

e Superior: the least amount of compression which produces the
largest image size.

Noise Filter

e (none)

* Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

» Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.
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Auto Color Detect tab

The Auto Color Detect tab provides the following options.

x
Preset: I:::E:‘;“':::Z
~Image Mode Ac!justments I Image Edge Fill I Blank :::g%zetegtion | About I
INorrnaI j Main I Layout I Image Processing o Color Detect | Dropout
Camera: Color Content
Front Image #1 =
[ Front Image #2 =
|| Back Image #1 Color Amount ———— " Color Threshold ——————————————
[ Back Image #2 I lﬁ‘ lﬁ‘
||||||||||| 4?_'I — 20_"
1 200 1] 100
Mode:
Black and White - Leam
Grayscale Usze the learn mode to determing the proper ;I
Color ro—y= - Colar Amount for detecting your color
documents. Set the Color Threshold value
Auto Detect Color and click the Learn button to begin,
e, | Amount Detected: 0
Threshold Detected: O

Copy | ok | Cancel Help Defaut

Color Content
* Low: documents require only a small amount of color to be saved as

color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.

Custom: makes the Color Amount and/or Color Threshold options
available.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.
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Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — if Low, Medium and High options do not give you the desired
results, use the Learn option.

1. Click Learn and follow the prompts.

2. Place at least 5 representative color documents in the input tray and
click OK. These documents will be analyzed and the recommended
color amount will be calculated for you.

3. Write down the Color Amount and Color Threshold values that
are displayed in the dialog box as these are the settings you will be
required to use in your application.

NOTE: These settings were calculated based on the representative
color documents scanned. If these values do not provide the
desired results with your production job set, you may need to
manually adjust the Color Threshold.
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Dropout tab The Dropout tab provides these options.

x
Preset: |IDefaut]i2]
~Image Mode Ac!justments I Image Edge Fill I Blank Image Detection [;\r:outm |
INorrnaI j Main I Layout I Image Processing I Auto Color Detect poi
Camera: Color Dropout
Front Image #1 Lalor:
[ Front Image #2

Mone -

|| Back Image #1
[ Back Image #2

Mode:

Black and White
Grayscale

Color

Auto Detect Grayscale
Auto Detect Color

Copy | 0K | Cacel |  Hep | Defaur |

The Dropout tab is used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

Color Dropout —the i1120 Scanner can drop out Red, Green or Blue.
None is the default.
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Adjustments tab

The Adjustments tab provides the following options.

x
Presst: I:::E:éw':::é:

- Image Mode I'U'Iai_n | Layout I Image Processing I Auto Color Detect I Dropout I
INorrnaI j Adjustments | Image Edge Fil I Blank Image Detection I About
Camera: r~ Brightness and Contrast

Front Image &1
[ Front Image #2 Manual j
D Back Image #1 Erighthess: [ |— ID 3:
[ Back Image #2 o
LContrast: _J— IU 3:
Mode
= r~ Calor Bal
Black and White e
Grayscale A -
Auto Detect Grayscale Red: —_— J— ID 3:
Auto Detect Color Vo f e
Green: _J— IU 3:
Blue: — J— ID 3:
-50 50

Copy | ok | Cancel Help Defaut

Brightness and Contrast

* (none)

» Manual: allows you to set specific values that will be used for all
images.

- Brightness — changes the amount of white in the color/
grayscale image. The values range from -50 to 50. The default is
0.

- Contrast — makes the image sharper or softer. The values range
from -50 to 50. The default is O.

Color Balance (not available for grayscale images)
* (none)
» Manual: allows you to set specific values that will be used for all
images.
- Red — changes the amount of red in the color image. The values
range from -50 to 50. The default is 0.

- Green — changes the amount of green in the color image. The
values range from -50 to 50. The default is O.

- Blue — changes the amount of blue in the color image. The
values range from -50 to 50. The default is O.

18
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Image Edge Fill tab The Image Edge Fill tab provides the following options.

x
Preset: |IDefaut]i2]
- Image Mode Main I Layout | Image Processing I Auto Color Detect I Dropout I
IN Adjustments Image Edge Fill | Blank Image Detection I About
lormal j
Camera: i~ Image Edge Fill
Front Image #1 Fill Color:
O Front Image #2

|| Back Image #1
[ Back Image #2

[bite |

Black and White
(Grayscale

Auto Detect Grayscale

Auto Detect Color Bottarn: IU.UU in

Copy | Ok | Cancel | Hep |  Defaut |
Image Edge Fill — fills the edges of the final electronic image by

covering the area with the specified color.

NOTE: When using Image Edge Fill, be careful not to enter a value too
large as it could fill in image data that you want to keep.

» Fill Color: allows you to select the color to fill the edges with.
- (none)
- White
- Black

» Frame Mode — fills in an equal amount of the selected color from
the Fill Color drop-down list on all sides of the image, or you can
select a value in the Left, Right, Top and/or Bottom area(s) from
each side of the scanned image to be filled.

A-61809 May 2013
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Blank Image Detection
tab

Blank Image Detection provides the following options.

Properties for KODAK i1120 on None x|
Preset: I:::E:é"::}:
~Image Mode Maih I Layout I Image Processing | Auto Color De.tect | Dropout I
INorrnaI j Adjustments I Image Edge Fil Blank Image Detection | About
Camem: r~ Blank Image Detection
Front Image #1 Mode
[ Front Image #2 IEontent j

|| Back Image #1

[ Back Image #2

Black and Wh [~ Grayscale

lack and White

Cyocal — [ 3
Auto Detect Grayscale

Auto Detect Color [ Colar

1KE 1o ke

r~ Learn Content

Uze the learn mode to determine Image content Amaunt,

Learn | Content: 0%

Copy | 0K | Cancel | Hep |  Defaut |

Blank Image Detection — allows you to configure the scanner to not
give blank images to the scanning application.

« Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied). Select the image size (KB), below which
an image is determined to be blank. Images with sizes less than the
number you select will not be created. If you use this option, you
must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make
an entry in these fields, all images are kept.

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.

20
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Configuring Scanner  To access scanner settings from the ISIS Driver, go into the Scan
settings Validation Tool as described earlier in this guide and access the ISIS
Driver.

KODAK i1120 on None x|

 Prezet Configurationz
=) 0

Freset Mame

[efault

Black andwhite Docurment with OCF Cuality
Black and‘white Docurent

Calar Diocurnent with JCR Quality

Color Document

Calar Phatagraph

Dezcription
Drefault zettings. ;I
=l
~ Properties
Image... Scanner...
ok | Cancel |

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring
Image settings” earlier in this guide for image configuration
procedures.

1
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Scanner tab The Scanner tab provides the following options.

x
Preset: |::5:E~3::23
Scanner | Mutfeed Detection | Log | About |
r~ Dacument Feeder
Paper Source:
|2DF =l
Feeder Pozition
Marmal -
v Autamatically start transpart
Shest Counter IU
- Timeout
¥ On
L -
=i |5 _lj
q 120 seconds
Besponge:
I Stop Scanning j
b aximurn Length: |1 i
Power Sawer: I 15 - l

QK I Cancel Help Defautt

Document Feeder
Paper Source: ADF — the scanner will only scan documents from the
input tray.

Sheet Counter — enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.

Timeout

* On — click On to set the amount of time, in seconds, the scanner will
wait once the last document enters the feeder before the timeout
occurs.

* Response — indicates the action that will be taken when the timeout
has been reached. Stop Scanning is the only selection. When the
timeout has been reached, scanning will stop and control will return
to the scanning application (i.e., ends the job).

Maximum Length — enter a value that indicates the length of the
longest document in your document set.

NOTES:

* Not all combinations of settings for Mode and Resolution are
supported at the larger lengths.

» The scanner’s throughput may be reduced for large lengths.

Power Saver — allows you to set the amount of time, in minutes, the
scanner has to be inactive before going into power saver mode.
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Multifeed Detection tab The Multifeed Detection tab provides the following options.
x|

Presat: |[Defauit]i2]

Scanner  Multifeed Detection |Log | About I

r— Length Detection

¥ On Calibrate... |
|11.nu i v Auto Set

—Action When Detected

I Stop Scanning j

QK I Cancel Help Diefault

Multifeed Detection

Length Detection — this option can be enabled or disabled. The
default is disabled. If enabled, select the maximum length of the
document that can be scanned without a multi-feed being detected.
Length detection is used when scanning same-sized documents to
check for overlap. For example, if you are scanning 8.5 x 11-inch (A4)
documents in portrait mode, enter a value of 11.25 inches (28.57 cm) in
the Max Length field.

» Auto Set: automatically sets the maximum length value to .50-inch
(1.27 cm) greater than the length of the currently selected page size.

Action — select what action you want the scanner to take when a
multifeed is detected. The condition will be logged in the scanner.

« Continue Scanning: the scanner will continue to scan. The user-
configured multifeed sound will be made by the scanner.

NOTE: Clicking the Speaker icon will display the Open dialog box
allowing you to select the desired tone (.wav file) for your alarm.
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Log tab The Log tab provides a listing of any errors that have been
encountered.

Properties for KODAK i1120 on None ﬂ

Preset: |IDefaut]i2]

Scannerl Multfeed Detection Log |N::out I

KODAK 11120 on None

oK | Cacel |  Hep | Defaur |

You can either save this information to a file by clicking the Save icon,
or click the Copy icon to copy the contents of the Log file to the
clipboard.
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About tab Displays information about your scanner and driver.
X

Preset: |Defauit]i2]

Scannerl Muttifeed Detection I Log About |

This diiver was witter ta e ekil100 Version 2.0.11304.5006

compatible with 1515(R) but KODAK 1100 Series Scanner
haz not been certified by EMC © 2013 EMC Corporation. &l rights reserved.
Corporation. QuickDiriver Yersion 2.0.11301.16001

Device Information:

EMLC. Captiva and 1515 are either registered trademarks or rademarks of EMC
Corporation in the United States and/or other countries. QuickDriver is a trademark,
of EMC Corporation. All other kademarks used herein are the property of their
Tespective owners.

= Copyright 2013 EMC Corparation. Al ights reserved.

Visit Kodak on the web:

Contact support

Product updates and documentation
Scanner product information

QK I Cancel Help Default
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Kodak

Eastman Kodak Company

343 State Street

Rochester, NY 14650 U.S.A.

© Kodak, 2013. All rights reserved.
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